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A oraki is the Maori name for Mt 
Cook, and the official name is 

now as in the title. Aoraki means 
cloud piercer and is a very apt name 
for New Zealand’s tallest mountain. 
 The trip there was a part of a ski 
trip in August, and we stayed at the 
Mt Cook village for two nights on the 
way back to Christchurch. We in this 
case being a friend, Heather Matthews 
and myself. Heather has travelled 
extensively all over the world but this 
was her first NZ visit (and my 
eighth!). 
 I had been to Mt Cook village in 
summer of 2008, but this was my first 
winter visit. And a walk I had wanted 
to do was up the Hooker Valley 
towards Aoraki.  
 It was a brilliant sunny day on the 
16th of August, with a temperature of 
slightly below zero. Recent snowfalls 
meant that there was snow cover all 
the way down to the valley floor. 
Although it is possible to walk from 
the village, it saves time to drive to the 
start of the trail some 2 km away.  

 The return trip is generally about 
three and a half hours, but for 
photographers it is substantially 

longer! The first part  of the trail was 
in the shadow of mountains, cold and 

quite icy, so we 
had to be 
careful with our 
footing. But as 
we rounded a 
corner we came 
into full sun and 
despite the 
f r e e z i n g 
temperature, we 
b o t h  g o t 
extremely hot 
and had to strip 
off layers.  

 To say that this is a landscape 
photographers’ paradise is an 
understatement. The mountains 
around are the most spectacular that I 
have seen anywhere. More so than in 
Canada and even now on our 
European trip, they beat the Swiss 
peaks that we have seen. But maybe I 
am biased as New Zealand is my 
favourite overseas destination. 
 The first significant feature along 
the trail is the memorial to the 
climbers who have died on the 
surrounding mountains, and there are 
plaques commemorating them on the 
pyramid structure. Some as young as 
eighteen have perished in this area. 
 We were on the lookout for 
avalanches, although the trail is quite 
safe. And we did hear some, a sharp 
crack followed by a rumble, but we 
could not locate them as the direction 

was impossible to pick. Also, by the 
time we heard them, it would have 
been some seconds after they occurred 
and they may no longer have been 
visible. 
 On the way we crossed three 
suspension bridges over the Hooker 
River. Being glacial fed it has the 
characteristic milky appearance due to 
the suspension of “glacial flour” 
which is finely ground rock produced 
by the slow movement of the glacier 
down the valley. 
 Needless to say we stopped many 
times to take many photos on the way. 
At the end of the trail is the 

Aoraki/Mt Cook 
Charles Kosina 

Some of the many plaques on the memorial 

Aoraki shrouded in cloud taken from Mt Cook Village 

Climbers’ Memorial 
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magnificent view of Aoraki towering above 
all the surrounding peaks. Of course we did 
not stop there and had to clamber down to 
the “beach” by the lake. Looked just like a 
white sand beach except in this case it was 
snow. There was a thin ice layer on the lake 
but careful testing proved that trying to walk 
on it would result in very cold and wet feet. 
And we were impressed by the small weird 
shaped icebergs floating in the lake. 
 Taking the easy way is not for 
photographers, and we also clambered some 
distance along the lateral moraine above the 
lake to get photos which were just that little 
bit different or better, or so we hoped! 
 In the end the return trip was about six 
hours, and worth every step of the way. I 
realised that we would probably never see it 
like this again. Such a perfect day is rare in 
those mountains, summer or winter and we 
were indeed fortunate. 

Along the well constructed trail with Aoraki on the right 

The official end of trail with picnic tables 

Heather testing the ice! 

Suspension bridge across the Hooker River 

There were many little icebergs on Hooker Lake 

Looking down on Hooker Lake from the lateral moraine 

Cover Photo 
 

Aoraki/Mt Cook Reflections  
in Hooker Lake 
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I  don't think I can write an article 
on this other than to say I stalked 

this insect for a good half hour to get 
the shot. No tripod, a 60mm macro 
lens hand-held and cropping. More 
luck that he was in my backyard. 
And patience - and 101 out-of-focus 
images to delete for my efforts. I'm 
really not good on the technical 
stuff. I don't even remember the 
aperture or length of my lenses half 
the time, but this was taken on my 
Canon 60D with Canon EF-S 60mm 
macro lens at ISO 1000, 1/30 at f7.1 
and -0.33 exposure adjustment. 
Could even have been taken upside 
down - he really was camera shy! 
 
(Ed: Nicole's image won a Highly 
Commended in the May EDI Set 
Subject Competition "Differential 
Focus"). 

How I did it - Stick Insect 
Nicole Andrews 

T he everlastings were taken up at 
Hotham many years ago. There 

are probably a number of ways to 
a c h i e v e  s i m i l a r  r e s u l t s . 
Unfortunately at that time, I 
flattened the layers after the image 
was processed and I am not able to 
show the layers at various stages as I 
worked through the process - I now 
save my processes as a PSD file! 
 The process from the RAW 
image to the finished image is set 
out below. The workflow on my 
Mac, using adjustment layers for the 
adjustments, was: 
 

1. Open the image in Adobe Bridge 
and make basic adjustments to 
exposure, contrast, etc. I now work 
in Lightroom and the basic 
adjustments are similar. 
 

2. Then open the image in 
Photoshop CS. 
 

3. Duplicate the image layer and 
trash the original Background layer. 
 

4. Using the Quick Select Tool, 
select the main flower carefully and 
secondary flowers. I used the Shift 
key + the QS Tool to add successive 
selections. 
 

5. Clean up the main flower 
selection with the Lasso Tool, using 
the Shift key to add and the Option 
key (Alt for Windows) to subtract. 
Ditto with the other flowers and 
buds though not as accurately. 

How I did it - Everlasting Impressions  
Tuck Leong 

6. Feather and save the selection. I 
think I made another copy here at this 
stage. 
 

7. Load and invert the selection  
Menu > Select > Inverse. 
 

8. From the Menu, select  
Filter > Blur > Motion Blur. 
 

9. Adjust the angle and distance of 
motion blur until the background is as 
desired. 
 

10. Invert again to just show the 
flowers and buds. 
 

11. Load selection and select Curve to 
add contrast to the flowers. 
 

12. Load selection and select 
Saturation to increase the saturation 
slightly. 
 

13. Shift + Option + Command + E 
(Shift + Alt + Ctrl + E for Windows) 
to combine the adjustment layers into 
a single layer. 
 

14. Load selection and sharpen the 
selected flowers. 
 

15. Convert to Profile (SRGB) - this 
flattens the layers (Ed: Edit > Assign 
Profile and choose sRGB from Profile 
drop-down menu). 
 

16. Size as required (Ed: Image > 
Image Size) and Sharpen slightly 
again. 
 

17. Menu > Image > Mode > 8 bits. 
 

18. Name and then save as Jpeg  
(File > Save As and select jpeg 
format). 

(Ed: Tuck's image won a Highly Commended in the April EDI Set 
Subject Competition "Fiddle Photo").  



D ear Club Members 
 It is a great privilege to be 

nominated as president of the 
Melbourne Camera Club and I hope 
that I will do the job justice. As I am 
newish to the club, I will use this 
opportunity to tell you a little more 
about myself.  
 Currently I am working full time 
as a clinical psychologist at the Royal 
Children’s Hospital and have an 
honorary research position at the 
Murdoch Childrens Research Institute 
a n d  a n  a d j u n c t  A s s o c i a t e 
Professorship at the University of 
Melbourne. I also work as a 
consultant to the Children’s Court 
Clinic. In terms of board and 
committee experience, I am a director 
on two other boards and Deputy 
Chair of the RCH Ethics Committee. 
I have had experience on several 
local, state and national committees 
over the years, including holding 
executive positions.  
 As you probably know, my 
partner Ken Bretherton has been a 
member of MCC for a couple of years 
and he talked me into undertaking the 
MCC Introductory Photography 
Course last year. It is a great course 
and I sincerely commend Robert 
Groom for his input into this course 
and hope it will continue. Inspired by 
the introductory course, I began 
coming to the Thursday night 
meetings and have entered the B 
grade print and EDI competitions 
each month this year. However, I am 
not entirely new to photography. I 
have always had a camera and an 

interest in photography: in fact, my 
p a r e n t s  g av e  me  a  K od a k 
Photographic Developer Kit when I 
was about 11 years old, so I even 
printed my own tiny black and white 
photographs for a while.  
 What impresses me about the 
club is the breadth and depth of 
experience of the members and the 
wide range of interest groups on offer, 
as well as the enthusiasm of the co-
ordinators. The monthly print and 
EDI competitions are such a good 
way to get feedback on your work in a 
supportive atmosphere. The Exposure 
magazine is an impressive publication 
and the club events I have attended 
have been high quality and 
informative.  
 I would like to see the club 
continue to prosper and maintain its 
image as a progressive and vibrant 
amateur photography club. It is with 
interest that I note that women were 
admitted to the MCC when it was 
known as the Working Men's College 
Photographic Club, way back in the 
1890s and I would really like to see 
more women in executive and 
leadership positions in the club in 
future.  
 My aim is to work hard for the 
club and to be inclusive and 
welcoming to all members. As I am 
relatively new, please make yourself 
known to me if you have the 
opportunity and, if you have any ideas 
or constructive criticism, please let 
myself and the Board know about 
them so we can continue to improve 
the club amenities and collegiality.  
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The Melbourne  
Camera Club 

ACN 004 344 549 ABN 79 004 344 549 
 

CLUB CONTACTS 
Clubrooms 

Corner of Ferrars and Dorcas Streets, 
South Melbourne 
Phone 9696 5445 

PO Box 1180, Sth Melbourne 3205 
www.melbournephoto.org.au 

 

 President 
Lesley Bretherton 

mcc-president@melbournephoto.org.au 
 

Secretary 
Grace Blake  

mcc-secretary@melbournephoto.org.au 
 

Treasurer 
Gary Richardson 

mcc-treasurer@melbournephoto.org.au 
  

General Questions 
mcc-info@melbournephoto.org.au  

 

Portrait Group  
Dion Chapman and John van Hirsel 

mcc-portrait@melbournephoto.org.au 
 
 

Club Facilities Booking Coordinator 
Selby Markham 

mcc-bookings@melbournephoto.org.au 
 

Introduction Photography Course  
Contact Secretary 

mcc-courses@melbournephoto.org.au  
New Member Orientation Coordination 

Frances Egan and Greg Hotson 
mcc-newmember@melbournephoto.org.au  

 

Traditional Darkroom 
 Printmakers Group  

Selby Markham  
 mcc-blackandwhite@melbournephoto.org.au 

2 

Digital Group 
Kelvin Rowley 

mcc-digital@melbournephoto.org.au 
 

Print Competition Steward 
 Shelly Black and Frances Egan 

mcc-print-comp@melbournephoto.org.au  
 

EDI Competition Stewards 
 Alan Harper, Gary Richards, Robert Fairweather 

mcc-edi-comp@melbournephoto.org.au 
 

Audio Visual Group 
 John Spring 

mcc-audiovisual@melbournephoto.org.au  
 

 International Competitions 
 Vacant  

 

Photo Discussion Group  
Simon Galbally  

mcc-photodiscuss@melbournephoto.org.au  
 

Librarian  
John Jovic 

mcc-library@melbournephoto.org.au  
 

Photographic Lighting Group 
David Gilliver 

mcc-lighting@melbournephoto.org.au 
 
 

MCC Website 
Manager - Alan Harper 

mcc-webmaster@melbournephoto.org.au 
Website Content - Gary Richardson 

mcc-webcontent@melbournephoto.org.au 
mcc-photos@melbournephoto.org.au 

 

Program Coordinator 
Vacant 

mcc-program@melbournephoto.org.au  
 

Exposure Editors 
Phil Marley and Charles Kosina 

mcc-exposure@melbournephoto.org.au 

President’s Report 
Lesley Bretherton 

The New MCC Board 
Back row left to right: Gary Richardson (Hon. Treasurer), Neil Brink,  

Grace Blake (Hon. Secretary), Alan Harper 
Front row left to right: Gail Morgan (Vice President), Lesley Bretherton (President),  

Mark Devaraj, Colin Booth, missing from photo - Ian Bock (Vice President) 
(Photo by John Spring) 
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F or close-up photography of native 
flowers and insects, I use a Canon 

7D fitted with an EF 100 mm f/2.8L 
Macro lens and used to rely solely on 
natural light, often manipulated by a 
silver/gold reflector. I typically mount 
the camera on a tripod, lock the mirror, 
set mode to aperture priority (Av) and 
ISO to 100, compose in live view and 
use a cable release. But I was 
commonly frustrated by subject 
movement (i.e. wind affected plant 
parts or running insects) and low light 
or bright sunlight/high shadow 
conditions.  I researched various light 
sources available and recently settled 
on a Canon MT-24EX macro twin-lite 

flash system fitted 
with a Vello 
Bounce Dome 
Diffuser on each 
f l a s h  h e a d 
(images of the 
system courtesy 
of the Canon 
website). 
 When the 
s y s t e m  i s 
switched to E-
TTL mode, it 
o f f e r s  f l a s h 
shooting in the camera’s program (P) 
mode (i.e. fully automatic) and 
aperture priority or manual exposure 
(M) modes. I shoot in either of these 
last two modes depending on subject 
movement and lighting conditions. 
 In aperature priority mode you set 
the F-stop to control depth of field and 
the shutter speed is set automatically. 
In most situations, the flash goes off 
first successfully illuminating the 
subject (i..e like a fill-flash), but the 
shutter remains open to give correct 
exposure of the background. The final 
images look very ‘natural’ but the 
often long shutter speeds means you 
need a tripod and are still open to 
subject movement. 

In manual exposure 
mode you set 
shutter speed and 
aperture manually. 
By setting a fast 
shutter speed (say 
1/125 to 1/250) you 
can usually cope 
w i t h  s u b j e c t 
movement and get a 
sharp image. It also 
means you can 
shoot hand held 
when chasing live 
insects in the field. 
If the background is 
close to the subject 
then you get even 
exposed images on 
s u b j e c t  a n d 
background. But 
often for close ups 
when you want to 
avoid distractions in 
the background, you 
ge t  a  ‘b lack 
background’ in this 

My favorite gadget 

Twin flash for close up photography 
Mark Smith 

mode. While not everyone’s cup-of-tea 
I like the look in circumstances where 
the subject largely fills the frame. 
 No matter what mode you choose, 
the system is very flexible because the 
orientation and the power of the flashes 
can be varied independently to create 
subtle shadows and a more natural and 
pleasing three dimensional effect of the 
main subject. The flashes are quite 
strong at short distances and I often 
work with diffusers fitted and flash 
exposure compensation at minus 2-3 
stops. I also back off power in one 
flash by altering the flash ratio which 
helps create shadows on the subject. 
 I haven’t discovered too many 
negatives. Perhaps the only constraint 
is the bulkiness of the control unit 
which makes it difficult for long 
stretches shooting hand-held. 
There are other features I haven’t 
explored yet (e.g. use of wireless slave 
unit flash) but I am very happy with 
the twin flash so far.  I’m looking 
forward to testing the system further 
and seeking out those beautiful and 
fascinating native flowers and insects.     
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I  needed a remote shutter release so 
that I could take photos while being 

some distance away from my camera 
so as not to disturb my subject and 
without blurring my images by 
causing camera shake through 
touching my camera to fire the shutter. 
I had hoped this would help with my 
bird photography and also enable me 
to do some star-trail shots at night 
time (see more on this below).  
 So I bought a long cable release 
(hӓhnel Remote Shutter Release) 
which included a 2.8 meter cable. This 

had the advantage that I could still 
activate autofocus and exposure using 
the half-pressure on the shutter release 
button and also do long exposures 
('bulb'). But being tethered to less than 
three meters away didn't put me far 
enough away not to scare the birds. 
 On discussing my needs further in 
Teds, I was pointed in the direction of 
a wireless remote control. The gadget 
I selected was the hӓhnel Giga T Pro II 
Interval Timer & Wireless Remote 
Control. And what a great gadget it is 
too. It comprises two parts. One is a 
receiver that conveniently slides into 
the camera's hot shoe and connects by 
cable to the cable remote control 
socket on the camera. The other is a 
transmitter that works over a distance 
of up to 100 meters, through walls and 
around corners .  See:  h t tp : / /
www.hahnel.ie/contentFiles/products/
pdfs/brochures/RemotesGigaT2%
20A4-24-09-14.pdf 
 I have had much success with this 
taking my bird shots, setting my 
camera up on a tripod and controlling 
it from 10 meters away, from where 
my movements don't disturb the birds 

as I sit in a deckchair 
with a beer. Some birds 
are very sensitive to 
noise and the sound of 
the shutter going off 
makes them fly away. 
However by setting my 
camera to high-speed 
burst and taking up to 
five frames a second has 
enabled me to take a 
ser ies  of  remote 
controlled shots birds 
looking straight down 
the barrel of the lens at 
the source of the noise at 
they fly away. Fabulous! 
 This wireless remote has many 
features. It allows single shot, 
continuous shooting, bulb (long 
exposures of 30-90 mins, longer than 
the maximum duration my camera can 
control itself), self-timer (i.e., delayed 
shutter release) and time-lapse over 
many hours. I have used the 
continuous shooting for my bird 
photos to catch birds on the wing or as 
they pass through a pre-focussed zone 
point. I have used the bulb setting for 
night sky and star-trails - inspired by 
the show of night sky shots at the club 

by Phil Hart. I have also done a few 
time-lapse sequences for use in AVs. 
The feature allows you to control the 
number of photos, interval between 
each, bursts, etc. One day I'll have a 
go at a full time-lapse AV, but I'll 
never have the patience for the 
breathtaking stuff Phil Hart does, such 
as his time-lapse videos of the aurora 
borealis captured over a whole night 
all done using a more sophisticated 
time-lapse-with-camera-movement 
device (eMotimo): see http://
p h i l h a r t . c o m / t a g / n i g h t - s k y -
photography/timelapse 

My favorite gadget 

Interval timer and remote control 
Phil Marley 

hӓhnel Giga T Pro II  
(courtesy of www. hahnel.ie) 

Star trails: Canon 7D 
EF16-35 f/2.8L II USM, ISO 1600, f/2.8, 23 min, 16 mm 

White-plumed honeyeater: Canon 7D, EF70-300mm f/4-5.6L IS USM, ISO 400, f/8.0,  
1/1600 sec max burst-mode, -0.67 exp comp, 93 mm 
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Exposure Editors 
 

Editor in Chief - Phil Marley 
Technical Editor - Charles Kosina 

 

 We welcome articles on travel, image 
processing tips, photos and anything else that 
may be of interest to photographers. Please 
send to: 

mcc-exposure@melbournephoto.org.au 
 

Deadline for November-December issue 
is 20 November, 2014 

Editors' report 
 for 2014 

Phil Marley and Charles Kosina 
(somewhere in Europe, I think it's 
Prague today) 
 

I t's been another good year for our 
club magazine Exposure.  We 

continue to be well supported by 
members willing to write articles and 
share their photography and 
photographic expertise with us all.  
 We continue to produce six full 
issues a year, essentially on schedule 
for the monthly print competition 
every second month. Many are 
international editions, put together 
by Charles somewhere exotic 
overseas.  And we continue to enjoy 
the support of our board for what 
remains one of the club's most 
expensive activities - for which we 
are very grateful. 
 We remain strong believers that 
Exposure is a major asset of our club 
- something we should be very proud 
of.  It forms a significant part of our 
annual record of activities.  It also 
records changing styles of our 
members' photography over the 
years and the changes in technology 
that increasingly affect how we do 
our photography.   
 Who would have thought, even 
five years ago, that we would run an 
annual competition for members in 
publishing photobooks.  We will 
certainly capture this and other 
significant events in our club's life in 
future issues of Exposure. 
 As always, we welcome 
comments on what we do include in 
the magazine and welcome any and 
all suggestions of other things we 
should consider including in the 
future. 
 Phil is correct, I am working on 
this in Prague! Distance is not an 
issue as long as one has a good 
Internet connection.  

Charles 

was followed with a number of other 
important awards in 2013. 
 Barbara loves the whole 
challenge of combining the different 
elements of AV, the images, audio 
and the ideas together with the power 
of the art-form. Frustrated with the 
difficulty of entering MAC made 
AVs, Barbara took up this challenge 
and overcame this frustration. The 
rest is history.  
 In addition to her skill and 
success with the audio-visual format 
Barbara has and continues to make a 
significant contribution to audio 
visual photography in general. She 
has served as the chair of the AV 
Division APS (2007-2014), chair of 
AV Sub-Committee VAPS (2007-
2014), a member of MC/ED APS 
(2007-2011). She also organised the 
International Gala of AVs in 2008, 
organised Autumn and APSCON 
National Judging Sessions from 2008 
to 2013. This shortlist of her 
achievements is just that, a shortlist 
with far too many to list on this 
nomination. 
 Barbara has been involved with 
organising or presenting many 
lectures and is an esteemed judge of 
audio visual competitions. Her club 
membership extends to the Ivanhoe 
Photographic Society, Melbourne 
C a m e r a  C l u b ,  A u s t r a l i a n 
Photographic Society and the Royal 
Photographic Society. 
 Barbara’s continued contribution 
to the world of audio-visual art have 
made her a worthy nominee for the 
AV-Medallion. 
 

Barbara Butler AV-AAPS SSAPS 

Barb was awarded the APS Audio 
Visual Medallion at the recent 
APSCON meeting in Ballarat. The 
medallion is presented to recognise 
outstanding achievement in the field 
of audio-visual photography. Her 
citation was as follows: 
 

T oward the end of 2005 Barbara 
Butler began her passion with the 

Audio Visual art-form. She was still 
recovering from major surgery and 
had ahead of her a long period of 
recovery. Prior to the surgery Barbara 
suffered from rheumatoid arthritis 
which prevented her from carrying 
copious amounts of equipment and in 
many ways this retarded her passion 
for photography. 
 With the advent of digital 
photography and subsequently the 
reduced cost Barbara was able to 
rekindle her passion and decided to 
spend her recuperation building her 
first serious audio-visual presentation. 
 I n  a  s e n s e ,  B a r b a r a ’ s 
commitment  to  photography, 
especially audio-visual is well 
documented, achieving awards such 
as AAPS with AV’s in 2008, top 
Australian entry in the Adelaide 
International Festival in 2009, many 
national acceptances over the period 
2010 to 2012. In addition Barbara 
achieved the top MCC AV for 2009, 
merit in 2010, Top in 2011 and Merits 
in both 2011 and 2012. 
 On the international scene 
Barbara was awarded the Bronze 
Medallion for “A Place for 
Reflection” at the 33rd Pomeranian 
Diaporama International in 2012. This 
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September Mono EDI of Month  Ray Brooks   Untitled  

August Mono EDI of Month Kelvin Rowley  
The Persuader 

2014 End-of-Year 
 Competitions 

 

Entries for the 2014 End-of-Year Competitions close on  
Thursday 6 November at 9.30pm. For details, see: 

 

www.melbournephoto.org.au/end-of-year-competition 

September Mono Print of Month  Ken Bretherton  Brisbane Ranges Cloudscape 
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September Colour Print of Month Robert Norman Shark Bay 

September Colour EDI of the Month  George Chan The right moment 
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August Mono Print of Month  John Spring Gums in fog Mt Macedon 

August Colour Print of the Month  David Ellis Island near Mykonos - sunset 

on the club's website remain the authoritative source for current 
scores and have the added advantage for EDI entries that the 
commended and highly commended images can be viewed. For the 
latest results, please refer to the comp scores webpage at:  

http://www.melbournephoto.org.au/competition-scores 

Monthly competition scores - note from the Editors 
 With this issue of Exposure, we propose to discontinue our 
previous practice of including results of the previous two months 
of monthly comp entries. Preparing these results for publication 
has been a substantial undertaking each time,  and it has created 
concerns with members when we make errors. The on-line scores 



June Colour Print of the Month  David Ellis  Guggenheim Bilbao 

August Colour EDI of Month   George Chan  Galloping down hill 
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